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Consider keeping your video on (if possible)

We're here together!

Kids? Pets? Spouses? No problem

But ultimately, you need be comfortable! (and you absolutely have the right to privacy at home)

Interrupt me!

Generally keep yourself muted but un-mute anytime to ask questions

Ask Questions!

Group trouble-shooting is really valuable

If you have a problem, others may also (or may have it in the future)

Screen-sharing

I may ask you to share your screen with the group (feel free to decline)

For privacy, close your email etc. Or just share your RStudio window

Online workshops can be challenging
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This is me!
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These are my creatures
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This is my garden
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This is my work*

(* On, with, and for) 6 / 55



Dr. Steffi LaZerte

Background in Biology (Animal Behaviour)

Working with R since 2007

Professional R programmer/consultant 

since 2017

Fourth year giving BU R Workshop!

rOpenSci Community Assistant

Introductions
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https://ropensci.org/


Dr. Alex Koiter

Backup helper today

Physical Geographer

Working with R since 2010

Assistant Professor in Geography and 

Environment, Brandon University

Introductions
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Name

Creatures? (share on camera!)

Background (Role, Area of study, etc.)

Familiarity with R or Programming

Something you're proud of!

What about you?
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Format

I will provide you tools and workflow to get started with R

We'll have hands-on, lecture, and demonstrations

R is hard: But have no fear!

Don't expect to remember everything!

Copy/Paste is your friend (never apologize for using it!)

Consider this workshop a resource to return to

About this Workshop
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ImpostR Syndrome
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ImpostR Syndrome

David WhittakerDavid Whittaker
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ImpostR Syndrome

David WhittakerDavid Whittaker

Moral of the story? 
Make friends, code in groups, learn together and don't beat yourself up
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Artwork by @allison_horst 14 / 55

https://github.com/allisonhorst/stats-illustrations


All about R



R is hard

Why R?
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But R is powerful (and reproducible)!

Why R?
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But R is powerful (and reproducible)!

Why R?

(I made these slides with Rmarkdown) 17 / 55



R is also beautiful

Why R?
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R is affordable (i.e., free!)

Why R?
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What is R?



A programming language is a way to give instructions in order to get a computer to do

something

You need to know the language (i.e., the code)

Computers don't know what you mean, only what you type (unfortunately)

Spelling, punctuation, and capitalization all matter!

For example

R, what is 56 times 5.8?

56 * 5.8

## [1] 324.8

R is Programming language
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R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

Use code to tell R what to do
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R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

R, save this value for later

steffis_mean <- mean(c(1, 2, 3, 4))

Use code to tell R what to do
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R, what is the average of numbers 1, 2, 3, 4?

mean(c(1, 2, 3, 4))

## [1] 2.5

R, save this value for later

steffis_mean <- mean(c(1, 2, 3, 4))

R, multiply this value by 6

steffis_mean * 6

## [1] 15

Use code to tell R what to do
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Code

The actual commands

Output

The result of running code or a script

Script

A text file full of code that you want to run

You should always keep your code in a script

Code, Output, Scripts
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Code

The actual commands

Output

The result of running code or a script

Script

A text file full of code that you want to run

You should always keep your code in a script

For example:

mean(c(1, 2, 3, 4))

## [1] 2.5

Code, Output, Scripts

Code

Output

Script
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RStudio is not R

RStudio is a User Interface or IDE (integrated development environment)
(i.e., Makes coding simpler)

But sometimes tries to be too helpful

RStudio vs. R

RStudioRStudio RR
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Changing Options: Tools > Global Options

General > Restore RData into workspace at startup (NO!)

General > Save workspace to on exit (NEVER!)

Code > Insert matching parens/quotes (Personal preference)

Projects

Handles working directories

Organizes your work

Packages

Can use the package manager to install packages

Can use the manager to load them as well, but not recommended

RStudio Features
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Let's take a look at RStudio



Your first real code!



# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

  geom_point()

Copy/paste or type this into the script window in RStudio
You may have to go to File > New File > R Script

Click anywhere on the first line of code

Use the 'Run' button to run this code, or use the short-cut Ctrl-Enter
Repeat until all the code has run

First Code
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# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code
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# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Packages 
tidyverse and palmerpenguins
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# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Functions: 
library(), ggplot() 

aes(), and geom_point()
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# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

+ 
(Specific to ggplot)
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# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Figure!
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# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Warning
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# First load the packages

library(tidyverse)

library(palmerpenguins)

# Now create the figure

ggplot(data = penguins, aes(x = body_mass_g, y = flipper_length_mm, colour = species)) +

  geom_point()

## Warning: Removed 2 rows containing missing values (geom_point).

First Code

Comments 
(Start with #)

35 / 55



Objects are things in the environment

(Check out the Environment pane in RStudio)

R Basics: Objects



Do things, Return things

Does something but returns nothing
e.g., write_csv() - Saves the mtcars data frame as a csv file

write_csv(mtcars, path = "mtcars.csv")

Does something and returns something
e.g., sd() - returns the standard deviation of a vector

sd(c(4, 10, 21, 55))

## [1] 22.78157

functions()
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Functions can take arguments (think 'options')

data, x, y, colour

ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +

  geom_point()

functions()
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By name:
mean(x = c(1, 5, 10))

## [1] 5.333333

By order:
mean(c(1, 5, 10))

## [1] 5.333333

Functions can take arguments (think 'options')

data, x, y, colour

ggplot(data = msleep, aes(x = sleep_total, y = sleep_rem, colour = vore)) +

  geom_point()

Arguments defined by name or by position

With correct position, do not need to specify by name

functions()
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By name:

mean(x = c(1, 5, 10, NA),

     na.rm = TRUE)

## [1] 5.333333

Watch out for 'hidden' arguments

functions()
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By name:

mean(x = c(1, 5, 10, NA),

     na.rm = TRUE)

## [1] 5.333333

By order:

mean(c(1, 5, 10, NA),

TRUE)

## Error in mean.default(c(1, 5, 10, NA), TRUE): 'trim' must

be numeric of length one

Watch out for 'hidden' arguments

functions()
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By name:

mean(x = c(1, 5, 10, NA),

     na.rm = TRUE)

## [1] 5.333333

By order:

mean(c(1, 5, 10, NA),

TRUE)

## Error in mean.default(c(1, 5, 10, NA), TRUE): 'trim' must

be numeric of length one

Watch out for 'hidden' arguments

This error states that we've assigned the argument trim to a non-valid argument

Where did trim come from?

functions()
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?mean

R documentation
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?mean

R documentation
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Vector (1 dimension)

my_letters <- c("a", "b", "c")

my_letters

## [1] "a" "b" "c"

Data frame (2 dimensions)

my_data <- data.frame(x = c("s1", "s2", "s3", "s4"),

                      y = c(101, 102, 103, 104),

                      z = c("a", "b", "c", "d"))

my_data

##    x   y z

## 1 s1 101 a

## 2 s2 102 b

## 3 s3 103 c

## 4 s4 104 d

Generally kept in vectors or data.frames

These are objects with names (like functions)

We can use <- to assign values to objects (assignment)

Data

rows x columns
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Use c() to create a vector
a <- c("apples", 12, "bananas")

Use x[index] to access part of a vector
a[3] # [1] "bananas"

Vectors contain one type of variable
(Even if you try to make it with more)

class(a) # [1] "character"

Vectors
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my_data

##    x   y z

## 1 s1 101 a

## 2 s2 102 b

## 3 s3 103 c

## 4 s4 104 d

Columns have different types of variables

x$colname to pull columns out as vector

x[row, col] to access rows and columns of a data frame

Data frames (also tibbles)
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Vectors

a <- c("apples", 12, "bananas")

a

Data frames

my_data <- data.frame(x = c("s1", "s2", "s3", "s4"),

                      y = c(101, 102, 103, 104),

                      z = c("a", "b", "c", "d"))

my_data

Try out the following code...

1. What is the output in your console?

2. How does your environment change (upper right panel)?

Your Turn: Vectors and Data frames
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Vectors

a[2]

a[2:3]     # What does : do?

a[c(1, 3)] # What does c() do?

Data frames

my_data[3, ]   # Why the comma?

my_data[3, 1]

my_data[, 1:2]

Try out the following code...

Your Turn: Vectors and Data frames
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Vectors

a[2]

## [1] "12"

a[2:3]     # What does : do?

## [1] "12"      "bananas"

a[c(1, 3)] # What does c() do?

## [1] "apples"  "bananas"

Data frames

my_data[3, ]   # Why the comma?

##    x   y z

## 3 s3 103 c

my_data[3, 1]

## [1] "s3"

my_data[, 1:2]

##    x   y

## 1 s1 101

## 2 s2 102

## 3 s3 103

## 4 s4 104

Try out the following code...

Your Turn: Vectors and Data frames
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Miscellaneous



R cares about spelling

R is also case sensitive! (Apple is not the same as apple)

Commas are used to separate arguments in functions

For example

This is correct:

mean(c(5, 7, 10))  # [1] 7.333333

This is not correct:

mean(c(5 7 10))

## Error: <text>:1:10: unexpected numeric constant

## 1: mean(c(5 7

##              ^

R has spelling and punctuation
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R cares about spelling

R is also case sensitive! (Apple is not the same as apple)

Commas are used to separate arguments in functions

For example

This is correct:

mean(c(5, 7, 10))  # [1] 7.333333

This is not correct:

mean(c(5 7 10))

## Error: <text>:1:10: unexpected numeric constant

## 1: mean(c(5 7

##              ^

R has spelling and punctuation

>80% of learning R is learning to
troubleshoot
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Spaces usually don't matter unless they change meanings
5>=6 # [1] FALSE

5 >=6 # [1] FALSE

5 >= 6 # [1] FALSE

5 > = 6 # Error: unexpected '=' in "5 > ="

Periods don't matter either, but can be used in the same way as letters
(But don't)

apple.oranges <- "fruit"

R has spelling and punctuation
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Use <- to assign values to objects
a <- "hello"

Use = to set function arguments
mean(x = c(4, 9, 10))

Use == to determine equivalence (logical)
10 == 10 # [1] TRUE

10 == 9 # [1] FALSE

Assignments and Equal signs
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Round brackets: ()

Identify functions (even if there are no arguments)

Sys.Date() # Get the Current Date

## [1] "2022-01-28"

Braces/Brackets
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Round brackets: ()

Identify functions (even if there are no arguments)

Sys.Date() # Get the Current Date

## [1] "2022-01-28"

Without the (), R spits out information on the function:

Sys.Date

## function ()

## as.Date(as.POSIXlt(Sys.time()))

## <bytecode: 0x5579c5603090>

## <environment: namespace:base>

Braces/Brackets
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Round brackets: ()

Identify functions (even if there are no arguments)

Sys.Date() # Get the Current Date

## [1] "2022-01-28"

Without the (), R spits out information on the function:

Sys.Date

## function ()

## as.Date(as.POSIXlt(Sys.time()))

## <bytecode: 0x5579c5603090>

## <environment: namespace:base>

Braces/Brackets

() must be associated with a function 
(Well, almost always)
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Square brackets: []

Extract parts of objects

LETTERS

##  [1] "A" "B" "C" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "O" "P" "Q" "R" "S"

## [20] "T" "U" "V" "W" "X" "Y" "Z"

LETTERS[1]

## [1] "A"

LETTERS[26]

## [1] "Z"

Braces/Brackets
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Square brackets: []

Extract parts of objects

LETTERS

##  [1] "A" "B" "C" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "O" "P" "Q" "R" "S"

## [20] "T" "U" "V" "W" "X" "Y" "Z"

LETTERS[1]

## [1] "A"

LETTERS[26]

## [1] "Z"

Braces/Brackets

[] have to be associated with an object
that has dimensions 

(Always)
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Use spaces like you would in sentences:
a <- mean(c(4, 10, 13))

is easier to read than

a<-mean(c(4,10,13))

(But the same, coding-wise)

Improving code readability
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Don't be afraid to use line breaks ('Enters') to make the code more readable

Hard to read

a <- data.frame(exp = c("A", "B", "A", "B", "A", "B"), sub = c("A1", "A1", "A2", "A2", "A3", "A3"),

res = c(10, 12, 45, 12, 12, 13))

Easier to read

a <- data.frame(exp = c("A", "B", "A", "B", "A", "B"),

                sub = c("A1", "A1", "A2", "A2", "A3", "A3"),

                res = c(10, 12, 45, 12, 12, 13))

(But the same, coding-wise)

Improving code readability
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Let's go!
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